Contents

Chapter 1 Getting Started ................................. 1
  Finding information ........................................ 1
  Overview ...................................................... 2
  Setting up the LE1700 ....................................... 5

Chapter 2 Features .......................................... 7
  Pen .............................................................. 8
  Front panel buttons ......................................... 9
  Status lights .................................................. 10
  Security ......................................................... 10
  Windows Security button .................................... 11
  Fingerprint reader ............................................ 11
  Display ......................................................... 11
  View Anywhere display (optional) ........................ 12
  Microphones .................................................. 12
  Speakers ....................................................... 12
  Ambient light sensor (ALS) ................................ 12
  DataGuard ...................................................... 12
  Infrared (IrDA) ................................................ 13
  USB 2.0 ports .................................................. 13
  Headphones port ............................................. 13
  Microphone port ............................................... 13
  Security slot .................................................... 14
  VGA port ....................................................... 14
  DVI-D port ..................................................... 14
  Docking port ................................................... 14
  Ethernet port .................................................. 14
  SD (Secure Digital) card slot ................................ 15
  PC card slot .................................................... 15
  SIM card slot ................................................... 15
  Wi-Fi (802.11a/b/g wireless) ................................ 16
  Wireless Broadband .......................................... 16
  Bluetooth wireless ........................................... 16
  Antenna ......................................................... 17
  Power adapter ............................................... 17
  Battery ......................................................... 18

Chapter 3 Using your Tablet PC ....................... 19
  Using Motion Dashboard .................................... 20
  Using the pen .................................................. 21
  Using Tablet PC Input Panel ............................... 22
  Configuring pen options .................................... 22
  Configuring front panel buttons ........................... 23
  Using USB ...................................................... 24
Using Ethernet ................................................................. 24
Using the display ............................................................ 24
  Adjusting the display brightness ...................................... 24
  Rotating the display ...................................................... 25
  Changing the display rotation sequence ............................ 25
  Setting up an external display ........................................ 26
  Using the built-in microphones ....................................... 27
    Setting up the angle of acceptance ............................... 27
    Setting up the skew angle ......................................... 28
  Connecting headphones, external speakers, or a microphone .... 28
Using speech recognition .................................................. 28
  Setting up speech recognition ...................................... 29
  Starting speech recognition ......................................... 29
Using power management .................................................. 29
  Using Standby ......................................................... 31
  Using Hibernate ...................................................... 31
Using the battery ........................................................... 32
  Checking battery power .............................................. 32
  Charging the battery ................................................ 32
  Battery and power management tips .............................. 33
  Removing and replacing the battery .............................. 33
  Swapping the battery ................................................ 34
Battery maintenance ....................................................... 34
  Long-term battery storage (not attached to tablet) ........... 34
  Disposing of used batteries ........................................ 35
Extended Battery Self-Conditioning .................................... 35
  Troubleshooting the Extended Battery ......................... 35
Using Motion OmniPass and the fingerprint reader ................... 37
  Capturing a fingerprint ............................................. 37
  Using password replacement ..................................... 39
  Using the password wizard ...................................... 40
  Logging on to a remembered site .................................. 40
  Setting up a smart card device ................................. 40
  Setting up strong logon security .............................. 42
Using Windows Security Center .......................................... 43
  Setting up users and passwords .................................. 44
    Setting up Windows user accounts ............................ 44
    Setting a BIOS password .................................. 44
    Setting up a hard disk drive (HDD) password .......... 45
Using Wi-Fi (802.11a/b/g) ................................................ 46
  Enabling or disabling Wi-Fi .................................... 46
  Setting up a Wi-Fi connection .................................. 46
Using Wireless Broadband ............................................... 47
  Activating your Wireless Broadband service ................. 47
  Enabling Wireless Broadband .................................... 47
  Starting the connection manager ............................... 47
  Connecting and disconnecting ................................... 48
Using Bluetooth ............................................................ 48
  Enabling or disabling Bluetooth .............................. 48
  Setting up a Bluetooth device .................................. 48
  If the device is not discovered .............................. 49
Getting Started

The Motion Computing LE1700 is a full-featured Tablet PC, combining performance, long battery life, and a lightweight, sleek design. The LE1700 offers the latest innovations in mobile computing: a user-focused design, unmatched mobility, and state-of-the-art security.

If you are new to Tablet PCs, use the information in this section to get started quickly. If you are already familiar with tablet computers, you can skip to the next chapter to find out about the features of the LE1700. If there are certain things you want to learn about your new Tablet PC, look on the Contents page.

Finding information
If you are viewing this PDF document on your screen, you can use the following methods to find information:

- In the Bookmark pane, click or tap a topic to view it. If the Bookmark pane is not visible, select View > Navigation Tabs > Bookmarks.
- On the Contents page, click or tap a topic to view it.
- To search the document, select Edit > Find.

Because you typically use a tablet pen instead of a mouse with a Tablet PC, we use the term tap instead of click in most situations.
Overview

The following illustrations show the buttons, slots, and ports on the Motion LE1700 Tablet PC. Although there are no controls on the back side, there is a sliding panel that covers the Extended Battery connector.

<table>
<thead>
<tr>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wireless switch</td>
<td>Enable and disable the Wi-Fi, Bluetooth, and Broadband Wireless adapters (page 16).</td>
</tr>
<tr>
<td>Power switch</td>
<td>Turns the Tablet PC on and off.</td>
</tr>
<tr>
<td>USB 2.0 ports</td>
<td>Connect USB devices, such as a mouse, digital camera, printer, or external storage device (page 13).</td>
</tr>
<tr>
<td>Audio in/ Microphone port</td>
<td>Connect a microphone or other audio source using a 3.5 mm jack (page 13).</td>
</tr>
<tr>
<td>Audio out/ Headphone port</td>
<td>Connect headphones, speakers, or audio equipment using a 3.5 mm jack (page 13).</td>
</tr>
<tr>
<td>DVI-D port</td>
<td>Connect an external monitor using DVI. Requires an optional adapter (page 14).</td>
</tr>
<tr>
<td>SIM card slot</td>
<td>Attach a SIM card (page 15).</td>
</tr>
<tr>
<td>VGA port</td>
<td>Connect an external monitor using the standard DB-15 VGA connector (page 14).</td>
</tr>
<tr>
<td>Gigabit Ethernet port</td>
<td>Connect to a 10/100/1000 Ethernet network (page 14).</td>
</tr>
<tr>
<td>Security slot</td>
<td>Connect a security cable to protect your tablet from theft (page 14).</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Battery</td>
<td>Powers the Tablet PC when it is not plugged in (page 18).</td>
</tr>
<tr>
<td>Antenna</td>
<td>Improves the reception of the Broadband Wireless adapter (page 17).</td>
</tr>
<tr>
<td>Microphones</td>
<td>Record sounds and use for speech recognition (page 12).</td>
</tr>
<tr>
<td>Esc button</td>
<td>Cancel the current task. Equivalent to the Esc key on a keyboard (page 9).</td>
</tr>
<tr>
<td>Function button</td>
<td>Activate secondary functions for other buttons (page 9).</td>
</tr>
<tr>
<td>Directional pad</td>
<td>Use for basic navigation. Equivalent to the arrow keys on a keyboard. The center button is equivalent to Enter (page 9).</td>
</tr>
<tr>
<td>Dashboard button</td>
<td>Open Motion Dashboard (page 9).</td>
</tr>
<tr>
<td>Rotate display button</td>
<td>Rotate the display orientation (page 9).</td>
</tr>
<tr>
<td>Speakers</td>
<td>Listen to music or other audio (page 12).</td>
</tr>
<tr>
<td>Ambient light sensor</td>
<td>Measures background light and can automatically adjust the display brightness (page 12).</td>
</tr>
<tr>
<td>Windows Security button</td>
<td>Use to log on to or lock your tablet. Equivalent to Ctrl+Alt+Del on a keyboard (page 11).</td>
</tr>
<tr>
<td>Fingerprint reader</td>
<td>Scan your fingerprints for added security. You can also use the fingerprint reader as a navigation device (page 11).</td>
</tr>
<tr>
<td>Status lights</td>
<td>Show battery and power status (page 10).</td>
</tr>
</tbody>
</table>
Power adapter port: Connect the power adapter (page 17).

SD card slot: Attach an SD (Secure Digital) card (page 15).

PC card slot: Attach a Type-I or Type-II PCMCIA card (page 15).

Infrared: Communicate with other devices using Infrared (page 13).

Air vent: Dissipates heat from the tablet.

Pen bay: Store the pen when not in use.

Pen tether: Attach the pen tether.

Antenna: Improves the reception of the Wireless Broadband adapter.

Docking attachments: Attachment points for docks, keyboards, and other accessories.

Docking port: Interface for docks, keyboards, and other accessories.

Accessory port: Connect Motion Computing accessories, such as external drives.
Setting up the LE1700
The LE1700 is self-contained, so you can start using it immediately. You should connect AC power until the battery is fully charged. Use the following steps to get started.

Step 1: Plug in the power adapter
- Plug the power cord into the power adapter. Insert the power cord into an outlet and the power adapter plug into the power adapter port on the Tablet PC.

Step 2: Connect the cables
- If you want to connect your Tablet PC to a network, insert an Ethernet cable into the Ethernet port.

To connect to a wireless network, see “Using Wi-Fi (802.11a/b/g)” on page 46. To connect using docking stations and other accessories, refer to the documentation for that product.

Step 3: Turn on the Tablet PC
- Slide the power switch on.

As the Tablet PC starts, the power light comes on.

The first time Windows starts, the Windows XP Tablet PC Edition 2005 Tutorials appear. If you do not want this screen to appear every time you start the computer, select Do not show me this again. To run the tutorials later, select Start > All Programs > Tablet PC > Tablet PC Tutorials.
Step 4: Calibrate the digitizer
With a Tablet PC, you frequently use a tablet pen instead of a mouse and keyboard for input. Use the pen to move the pointer around the screen, and tap the screen to click. Use Tablet PC Input Panel and handwriting recognition to enter text.

The digitizer detects the position of the pen on the display. You should calibrate the digitizer the first time you start the Tablet PC, and again whenever the pointer does not align with the pen tip.

To calibrate the digitizer
1. Press the Dashboard button ( ) to start Motion Dashboard.

   You can use Motion Dashboard to configure your Tablet PC and to start commonly used tablet applications. See “Using Motion Dashboard” on page 20.

2. Under Pen & Tablet, tap Calibrate Digitizer.

3. Follow the instructions in the calibration program.

   Note: If you are left-handed, see “How do I adjust the Tablet PC for left-handed use?” on page 68.

Step 5: Get familiar with your Tablet PC
Motion Computing offers free Web-based Quick Start Training that you can use to familiarize yourself with the features of your Tablet PC. If you are new to tablet computing, you can use the training to get started quickly. You can find the training at http://training.motioncomputing.com.

You can also use the Windows Tablet PC tutorials to learn about the special capabilities of Windows XP Tablet PC Edition. Windows XP Tablet PC Edition includes many features that other editions of Windows XP do not, such as pen support, digital ink input, and handwriting recognition.

To start the tutorials, select Start > All Programs > Tablet PC > Tablet PC Tutorials.
The Motion Computing LE1700 Tablet PC has the power and features of a notebook computer, while giving you the added mobility and versatility of a tablet computer.

Use the information in this chapter to get more familiar with the hardware features of your LE1700 Tablet PC, such as buttons, slots, connectors, and wireless adapters.

The LE1700 Tablet PC includes the following features:

- Intel® Core™2 Duo 1.5 GHz Processor or Intel® Core™ Solo 1.2 GHz Processor
- Mobile Intel® 945GM Express Chipset
- Integrated Wi-Fi (802.11a/b/g) networking
- Integrated Bluetooth® and infrared
- Integrated Wireless Broadband
- Integrated DataGuard to help protect the hard drive
- DDR2 RAM
- 12.1" TFT LCD (XGA or SXGA+)
- Integrated fingerprint reader
- Integrated Ethernet
Pen

An important difference between traditional PCs and Tablet PCs is that you frequently use the tablet pen to interact with the computer instead of a mouse and keyboard. The pen includes a pressure-sensitive tip, a function button, and an eraser. The pen contains no batteries and requires no external power.

For information about using the pen, see “Using the pen” on page 21.
Front panel buttons
You can use the buttons on the front of the tablet to perform many functions without having to use the pen. The buttons are customizable, so you can modify their functions to suit the way you work. See “Configuring front panel buttons” on page 23.

<table>
<thead>
<tr>
<th>Button</th>
<th>Primary</th>
<th>Secondary (Function + button)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esc</td>
<td>Cancels the current task. Equivalent to the Esc key.</td>
<td>Alt + Tab</td>
</tr>
<tr>
<td>Function</td>
<td>Activates secondary function for other buttons</td>
<td>N/A</td>
</tr>
<tr>
<td>Directional pad</td>
<td>Use to move the pointer or navigate through documents. Equivalent to arrow keys on a keyboard. The center button is equivalent to Enter.</td>
<td>Left = Shift + Tab Right = Tab Up = Page Up Down = Page Down</td>
</tr>
<tr>
<td>Dashboard</td>
<td>Starts Motion Dashboard</td>
<td>Starts Windows Journal</td>
</tr>
<tr>
<td>Rotate screen</td>
<td>Rotates the orientation of the display</td>
<td>Starts Tablet PC Input Panel</td>
</tr>
</tbody>
</table>

The directional pad orientation rotates to match the display orientation. To move the pointer in a certain direction, press that direction on the pad regardless of orientation. For example, the “up” direction in landscape orientation becomes the “left” direction in portrait orientation.
Status lights
You can use the indicator lights on the front of the LE1700 to monitor the status of the tablet. The following illustration shows the status lights on the LE1700.

<table>
<thead>
<tr>
<th>Light</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>Steady blue</td>
<td>On</td>
</tr>
<tr>
<td></td>
<td>Blinking blue</td>
<td>The Tablet PC is in Standby mode</td>
</tr>
<tr>
<td>Battery</td>
<td>Steady blue</td>
<td>The battery is fully charged and the Tablet PC is running on AC power</td>
</tr>
<tr>
<td></td>
<td>Steady amber</td>
<td>Charging</td>
</tr>
<tr>
<td></td>
<td>Flashing amber (fast)</td>
<td>5% charge or less remaining</td>
</tr>
<tr>
<td></td>
<td>Flashing amber (slow)</td>
<td>The battery is too hot to charge</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>The Tablet PC is running on battery power</td>
</tr>
</tbody>
</table>

Security
The LE1700 provides a safe computing environment that enables strong security protection and serves as the foundation for complementary security technologies.

The core security features include password-protected Phoenix TrustedCore BIOS with HDD locking and networking control, a built-in fingerprint reader, a universal security lock, the Dashboard Security Center, TPM (Trusted Platform Module), and a Smart Card-ready platform.

With the built-in TPM and Infineon Security Platform Tools, you can create and manage digital certificates for user and platform authentication. These features are most commonly used by enterprises and enabled by the system administrator. To learn more about TPM, go to www.motioncomputing.com/support/support_documentation.asp.
Windows Security button
You can use the Windows Security button to log on to or lock your Tablet PC. Pressing the Windows Security button is equivalent to pressing Ctrl+Alt+Del on a keyboard.

Fingerprint reader
Using the fingerprint reader, you can log on to your Tablet PC by scanning your fingerprint instead of entering a password. This presents an added level of security for your tablet.

You can use the OmniPass application to associate your fingerprint with passwords for Web pages and other applications. You can also use the fingerprint reader as a navigation device. Move your finger on the fingerprint reader to move the pointer on the screen.

Note: The scroll function is disabled while scanning a fingerprint.

For information about setting up and using the fingerprint reader, see “Capturing a fingerprint” on page 37.

Display
The LE1700 includes a 12.1-inch display with the following features:
• A highly readable LCD (liquid crystal display).
• XGA (1024 × 768) or SXGA+ (1400 × 1050) resolution.
• A protective layer that offers a firm writing surface and minimizes glare.
• A digitizer panel that enables handwritten entry with the tablet pen.
View Anywhere display (optional)
The View Anywhere™ display option enhances outdoor viewing and bright-light viewing environments. The View Anywhere display includes all the standard display features plus:

- A protective layer that improves the sunlight contrast ratio and significantly reduces reflection and glare.
- Improved sunlight contrast ratio, which enhances viewability at wide viewing angles.
- Reduced reflection and glare and improved light pass-through efficiency.

Microphones
The LE1700 is equipped with integrated microphones that you can use to record audio, dictate notes, and use voice commands without the need for an external microphone.

You can also use the Microphone port to connect an external microphone or microphone headset. See “Connecting headphones, external speakers, or a microphone” on page 28.

Speakers
The LE1700 is equipped with integrated stereo speakers that you can use to listen to music, movies, or other multimedia applications.

You can also use the headphones port to connect external speakers or headphones. See “Connecting headphones, external speakers, or a microphone” on page 28.

Ambient light sensor (ALS)
If you have dynamic brightness selected and are running on battery power, the ambient light sensor measures the surrounding light and adjusts the display brightness and contrast accordingly. This ensures that you have proper settings for all lighting conditions. To enable dynamic brightness, see “Adjusting the display brightness” on page 24.

DataGuard
The LE1700 includes the DataGuard feature, which detects shocks, extreme vibrations, and falls. If detected, DataGuard moves the drive heads away from the disk, which can prevent hard drive failures and data loss. For more information, go to Control Panel and open DataGuard.
Infrared (IrDA)

Your Tablet PC has integrated Infrared, which you can use to connect your tablet to other computers and devices wirelessly. The LE1700 supports the IrDA standard (Infrared Data Association), which ensures that you can connect to printers, modems, cellular phones, and other devices. Infrared has a range of approximately one meter, and requires line-of-sight alignment between the two devices.

USB 2.0 ports

Two USB 2.0 (High-speed USB) ports can be used to attach any USB device such as a mouse, digital camera, printer, or external storage device. The USB ports are compatible with older USB devices (USB 1.1). For more information, see “Using USB” on page 24.

Headphones port

The headphones port is on the left edge of the Tablet PC. It is marked with a small headphones symbol and is designed as an audio output channel only. You can attach headphones or external speakers to this port.

For more information, see “Connecting headphones, external speakers, or a microphone” on page 28.

Microphone port

The microphone port is on the left edge of the Tablet PC. It is marked with a small microphone symbol and is designed as an audio input/line in channel only. You can attach an external microphone directly to this port to enhance your audio recording capabilities. The internal microphones are disabled when an external microphone is attached.

For more information, see “Connecting headphones, external speakers, or a microphone” on page 28.
Security slot
You can use the security slot to attach your tablet to a desk, table or other fixture. You must purchase a security lock separately.

VGA port
You can use the VGA port to connect standard VGA monitors. When you attach an external monitor, you can use the external monitor only, or the external monitor and the Tablet PC display together. See “Setting up an external display” on page 26.

DVI-D port
The DVI-D (Digital Video Interface) connector is on the left edge of the tablet and is identified by the DVI-D designation. With an optional DVI-D cable, you can attach a digital video monitor. For more information, go to the Motion Computing accessories page at www.motioncomputing.com/accessories.

When you attach an external monitor, you can use the external monitor only, or use the monitor and the Tablet PC display as a mirrored or extended display. See “Setting up an external display” on page 26.

Docking port
The LE1700 has a docking port that you can use to connect the tablet to a dock or other accessory. When the tablet is connected to a dock, the port connections are replicated on the dock. This enables you to connect a monitor, keyboard, mouse, or external drive to the dock and easily dock and undock the tablet. For more information about docks and other accessories, go to the Motion Computing accessories page at www.motioncomputing.com/accessories.

Ethernet port
The LE1700 comes with an integrated 10/100/1000Base-T Ethernet port (RJ-45), which you can use to connect to an Ethernet network or another computer.

For more information, see “Using Ethernet” on page 24.
SD (Secure Digital) card slot
The SD card slot holds one SD card for storage or accessories. SD memory cards are a storage media that provide large capacity and fast access.

- To insert an SD card, place it in the slot, label side up, until it clicks into place.
- To remove the SD card, press the card in slightly until it pops out.

PC card slot
The PC card slot holds one Type-I or Type-II PC card for networking, memory expansion, or accessories. PC cards are also called PCMCIA cards.

- To insert a PC card, place it in the slot with the label side up.
- To remove the card, push the button next to the slot until it pops out, then push it in again to eject the card.

The LE1700 includes a plastic blank card in the PC card slot. To protect the PC card slot, you should leave the blank card in place when you do not have a PC card in the slot.

SIM card slot
The SIM card slot holds one SIM (Subscriber Identity Module) card. A SIM card is a smart card, about the size of a postage stamp, that stores information about your wireless account.

You need to use a SIM card only if you are using Wireless Broadband on an HSDPA (High Speed Downlink Packet Access) network. Contact your service provider for details.

- To insert a SIM card, place it in the slot, label side up, until it clicks into place.
- To remove the SIM card, press the card in slightly until it pops out.
Wi-Fi (802.11a/b/g wireless)

Your Tablet PC has integrated Wi-Fi (802.11a/b/g) that you can use to connect to the Internet and other computers wirelessly. You can use Wi-Fi in your home, and in many schools, hotels, airports, and restaurants.

**Note:** Wireless access requires an 802.11a, 802.11b, or 802.11g access point. Internet access requires a working Internet connection.

Your ability to use Wi-Fi depends on the several conditions:

- Distance from the access point.
- Ability to connect to the access point.
- Access rights (which may require an account fee, user name, password, an/or network set up through an administrator).
- Security settings, such as whether the network broadcasts a network name or uses encryption.

For more information, see “Using Wi-Fi (802.11a/b/g)” on page 46.

Wireless Broadband

The LE1700 Tablet PC is available with an optional Wireless Broadband adapter that you can use to send and receive data wirelessly. By using Wireless Broadband, you can browse the Internet, send and receive email, connect to your company's intranet, or use Web-based applications.

Wireless Broadband is based on cellular network technology, so you can use it in more places than other wireless technologies. With Wireless Broadband, your Tablet PC connects to a service provider's base station, which in turn is connected to the Internet. Unlike Wi-Fi, you do not need to search for Wi-Fi hotspots or buy base stations. You can typically use Wireless Broadband anywhere you can use your mobile phone. For more information, see “Using Wireless Broadband” on page 47.

Bluetooth wireless

Your Tablet PC has an integrated Bluetooth adapter. With Bluetooth, computers and other devices—such as mice, keyboards, cameras, and PDAs—can be interconnected using a short-range wireless connection. Bluetooth devices can connect wirelessly at distances up to 33 feet (10 meters).

For more information, see “Using Bluetooth” on page 48.
Antenna
The antenna improves the reception of the optional Wireless Broadband adapter. You can raise the antenna if your Wireless Broadband reception is poor.

To raise the antenna, insert your finger into the notch and lift up.

For information about using Wireless Broadband, see “Using Wireless Broadband” on page 47.

Power adapter
The power adapter provides power to the Tablet PC and charges the battery when it is in the Tablet PC. The power adapter has the following components:
- Power cord
- Power adapter

WARNING: Use the Motion power adapter with your Motion Tablet PC only. Do not use the adapter to power any other electronic devices.
Battery
The LE1700 includes a high-capacity Lithium-ion battery that mounts at the top of the Tablet PC. Under normal conditions, you can run the tablet on battery power for up to three hours. You can maximize battery life by optimizing your power scheme. See “Using power management” on page 29.

For information about charging and checking battery status, see “Using the battery” on page 32.

An optional extended battery is also available. The small sliding door on the back of the Tablet PC is for connecting the extended battery. For more information, go to the Motion Computing accessories page at www.motioncomputing.com/accessories.

**CAUTION:** To avoid personal injury, handle the battery with care. Do not open, puncture, short, or expose it to fire or water. Keep the battery in an ambient temperature of less than +104°F (+40°C). For example, do not leave the battery in a closed car in hot weather for an extended time. For more information, see the Safety and Regulatory Guide included with your Tablet PC.
The LE1700 Tablet PC runs Microsoft Windows XP Tablet PC Edition, which includes ink-to-text and word recognition, voice recognition, and improved security to help defend against viruses, worms, and other threats. And unlike PDAs or other handheld devices, the LE1700 can run any Windows XP-compatible application.

Use the information in this chapter to learn about common tasks, such as using the tablet pen to enter text, using Motion Dashboard, using speech recognition, and customizing the tablet to fit the way you work.
Using Motion Dashboard

Motion Dashboard puts many common tablet-related settings and tasks at your fingertips. For example, you can enable or disable Bluetooth and Wi-Fi, calibrate the digitizer, or check your remaining battery power.

To start Motion Dashboard

- Press the Dashboard button ( ) on the front of the tablet.

When you change a setting on Motion Dashboard, the change occurs immediately. You do not need to tap Apply or OK.

For more information, see Motion Dashboard Help.
Using the pen

You can use the tablet pen to write on the display and navigate the operating system. A pen can feel more natural in your hand than a mouse, and you can use the pen while standing or walking. The following table show the various pen actions and their mouse equivalents.

<table>
<thead>
<tr>
<th>Mouse action</th>
<th>Pen equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point</td>
<td>Point</td>
</tr>
<tr>
<td>Click</td>
<td>Tap</td>
</tr>
<tr>
<td>Double-click</td>
<td>Double-tap</td>
</tr>
<tr>
<td>Drag</td>
<td>Drag</td>
</tr>
<tr>
<td>Right-click</td>
<td>Tap and hold</td>
</tr>
<tr>
<td>Right-click</td>
<td>Press Function button and then tap</td>
</tr>
</tbody>
</table>

Some software applications, such as Microsoft Word, support ink drawing and ink annotations. Some applications, such as art or drawing programs, are designed especially for ink input. For more information about a particular application, open the application help and search for “pen”, “ink”, or “tablet”.

You can use Tablet PC Input Panel instead of a keyboard to enter text. For more information, see “Using Tablet PC Input Panel” on page 22.

Store the pen in the pen bay when not in use. To store the pen in the pen bay, insert it into the bay and press it until it clicks. To remove the pen, press it again. If you have the pen tether attached, ensure that you have released the pen before you pull it out using the tether.

The pen includes extra tips. You can use the included replacement tool to change the tips. See “Replacing pen tips” on page 57.

**Important:** The Tablet PC responds only to the tablet pen. Do not use traditional pens or other pointing devices with the Tablet PC.
Using Tablet PC Input Panel
You can use Tablet PC Input Panel instead of a keyboard to enter text on your Tablet PC. Use the writing pad or the character pad to convert your handwriting to text, or tap characters using the on-screen keyboard.

You can also use Input Panel to dictate text or use voice commands. For more information about Speech Recognition, see “Using speech recognition” on page 28.

The following illustration shows Input Panel open to the writing pad.

![Input Panel Illustration]

**To start Input Panel**
- Do one of the following:
  - Tap at the place you want to enter text, such as a text box. Then tap the Tablet PC Input Panel icon ( ).
  - Tap the Tablet PC Input Panel icon on the Windows taskbar.

To switch among the writing pad, the character pad, and the on-screen keyboard, tap the appropriate button.

Use the tutorial to get acquainted with Input Panel. Tap **Help**, then tap **Tutorial**.

For more information about using Input Panel, see the Input Panel Help.

Configuring pen options
You can use pen options to enable or disable the pen function button and the pen eraser.

**To configure pen options**
1. Open Motion Dashboard to the Pen & Tablet panel (page 20).
2. Tap the **Tablet & Pen Settings** button.
3. In the Tablet and Pen Settings window, tap the **Pen Options** tab.
4. For pen buttons, do one of the following:
   - To enable the function button, select **Use pen button to right-click**.
   - To enable the eraser, select **Use the top of the pen to erase**.
Configuring front panel buttons

As you become more familiar with your Tablet PC, you may want to customize the buttons on the front panel. You can configure the buttons to start your favorite program, run a command, or enter a key combination.

To change the front panel buttons
1. Open Motion Dashboard to the Pen & Tablet panel (page 20).
2. Tap the Tablet and Pen Settings button.
3. Tap the Tablet Buttons tab.
4. Select the button combination you want to change. The currently selected buttons appear in red.
5. Tap Change.
6. For Action, select an action to assign to the button.

For some actions, you must enter more information, such as the location of a program to start. Tap Help for more information.
Using USB
You can use the two integrated USB 2.0 ports to connect USB devices, such as digital cameras, printers, external storage devices, keyboards, and mice. USB devices typically use power from the computer, so you should use AC power or have adequate battery power while you are using USB devices.

To use a USB device, connect the device to the USB port ( ) on the side of the Tablet PC.

When you connect a USB device, the Tablet PC recognizes it and loads the appropriate device driver. You can connect and disconnect USB devices without shutting down your computer.

Using Ethernet
You can use the integrated 10/100/1000Base-T Ethernet port (RJ-45) to connect to an Ethernet network, high-speed modem, or another computer.

To connect to an Ethernet network or device, connect the Ethernet cable to the Ethernet port ( ) on the left side of the Tablet PC.

Using the display
Use the procedures in this section to customize your display settings. You can adjust the brightness level, rotate the display, and change the order in which the display rotates.

Adjusting the display brightness
Use this procedure to change the brightness of the display.

To adjust the display brightness
1. Open Motion Dashboard to the Display panel (page 20).
2. Set the Brightness slider to the appropriate level.
   
   For optimal battery conservation and viewability, set the brightness scale to the mid-point or slightly above.
3. Select one of the following:
   - **Fixed.** Sets the display brightness to a constant level. Use the slider to adjust the display to the desired brightness level. The ambient light sensor is not used with fixed brightness.
   - **Dynamic.** Uses the ambient light sensor to maintain an appropriate brightness level for the current lighting conditions. Using dynamic brightness helps to reduce power consumption while running on battery power.
Rotating the display
You can easily change the screen orientation to fit your current task. You may want to use the portrait orientation for filling out forms or reading an e-book. At other times, you may want a landscape orientation for Web browsing or sketching.

To rotate the display
• Press the Rotate (ROTATE) button on the front of the tablet.

Note: If you change the screen orientation, you may need to recalibrate the tablet pen. See “Calibrate the digitizer” on page 6.

Changing the display rotation sequence
Use this procedure to change the order in which the display rotates.

To change the rotation sequence
1. Open Motion Dashboard to the Pen & Tablet panel (page 20).
2. Tap the Tablet & Pen Settings button.
3. In the Tablet & Pen Settings window, tap the Display tab.
   
4. For Sequence, click Change.
5. Select orientations for 1 and 2.

   You can select None to skip a particular view in the rotation sequence.
Setting up an external display

If you want more desktop real estate, or the flexibility of multiple monitors, you can connect an external display, such as a monitor or projector.

You can extend your display to the external monitor, mirror your display on the external monitor, or use the external monitor only. Because the tablet pen does not work on the external display, you should typically use a keyboard and mouse when you have an external display attached.

To set up an external monitor

1. Connect the monitor cable into the appropriate display port on the Tablet PC or docking station. You can use the VGA port or the DVI-D port (with optional adapter).
2. Plug in the external monitor and turn it on.
3. If necessary, install software and drivers for the monitor. See the manufacturer’s documentation for more information.
4. Open Motion Dashboard to the Display panel (page 20).
5. For Display Scheme, select one of the following:
   - **Mirror Display.** Duplicates the Tablet PC display on the external monitor or projector. The same desktop is visible on both displays. The external monitor must use the same display resolution as the Tablet PC.
   - **Extended with Monitor Primary.** Enlarges the desktop area to include the external monitor as the primary monitor. The external monitor can use a different display resolution than the Tablet PC.
   - **Extended with Tablet Primary.** Enlarges the desktop area to include the external monitor as the secondary monitor. The external monitor can use a different display resolution than the Tablet PC.
   - **Monitor Only.** Uses the external monitor only.
   - **Tablet Only.** Uses the Tablet PC display only.

To learn more about custom monitor schemes, go to www.motioncomputing.com/tips.
Using the built-in microphones

You can use the built-in microphones to record audio, dictate notes, and use voice commands. The two microphones are used at the same time to optimize sound detection for speech recognition and voice recording.

You can use the Speak Anywhere acoustics software to fine tune the built-in microphones to suit your environment. The software enables you to use the microphones in a variety of settings, including small or large groups, noisy environments, or for individual dictation or voice commands. The software improves the microphone reception by:

- Removing all sounds outside of the user-defined angle of acceptance.
- Minimizing background and ambient noise.
- Removing echo caused by the microphone picking up the speaker output (feedback).

Setting up the angle of acceptance

The angle of acceptance defines how the built-in microphones detect sounds. You can remove all sounds outside of a specified angle. When recording, dictating, or using voice commands, you may need to adjust this setting until you achieve the desired results.

To set up the angle of acceptance

1. Open Motion Dashboard to the Audio panel (page 20).
2. Under Microphone, select one of the following:
   - **Narrow angle.** Configures the microphones to detect sound on a narrow angle near the bottom center of the display. Narrow is the best setting for dictation, Voice over IP, or "voice noisy" environments.
   - **Medium angle.** Configures the microphones to detect sound at a wider angle. Medium is the best setting for a small group, conference table, or "voice quiet" environment.
   - **Wide angle.** The microphones detect sound at the widest angle. If the microphones are detecting too much background noise, change to a narrower setting.

If a sound is loud enough, the microphones will pick it up regardless of the angle of acceptance setting.

You can limit the detection of these outside sounds by turning down the microphone level and speaking louder. This reduces the microphones' range and restricts the capability to detect extraneous sounds.
Setting up the skew angle
The default sound detection area is directly in front of the Tablet PC, but you can use the skew angle to offset the sound detection area toward one side or the other.

To set up the skew angle
1. Open Motion Dashboard to the Audio panel (page 20).

2. Under Microphone, ensure that Narrow Angle or Medium Angle is selected. You cannot use a skew angle with the Wide angle setting.

3. Move to where you want the microphone to detect your voice.

4. Tap Calibrate. A block of text appears.

5. Read the text aloud, speaking normally towards the Tablet PC microphones. This process takes about 30 seconds.

In many cases, you will not need to calibrate the built-in microphones because the audio system filters out many unwanted sounds. If you are dictating in an office or recording during a meeting, the audio system may work well with no additional calibration.

Note: The audio system does not store calibrations. If you change to another angle or position and then return to the previous one, you must re-calibrate the audio system.

Connecting headphones, external speakers, or a microphone
You can connect headphones or external speakers to the headphones port using a 3.5 mm plug. When speakers or headphones are connected, the internal speakers are disabled.

You can connect an external microphone or headset to the microphone port using a 3.5 mm plug. When a microphone is connected, the internal microphones are disabled.

Using speech recognition
You can use speech recognition to interact with your Tablet PC by voice. You can dictate documents and emails, or use voice commands to control programs.

• Dictation mode. With Dictation mode, your computer listens to everything you say and converts your words to text. You can use dictation mode to enter text directly into any document or text box.

• Voice command mode. With Voice command mode, your computer listens for specific words that correspond to a list of available voice commands. You can use commands to switch between programs, save documents, copy, paste, or undo.
Setting up speech recognition
Before you can use speech recognition, you must configure the microphones and train the system for the characteristics of your voice. The entire process takes about 10 minutes. You should move to a quiet environment before starting this procedure.

To set up speech recognition
1. Open Motion Dashboard to the Audio panel (page 20).
2. Ensure that the speakers and microphone are set to appropriate levels.
4. Tap the Tools and Options button ( ), then tap Speech.
5. Tap Next and follow the instructions in the setup program.

You can improve speech recognition by running additional speech training sessions. In Control Panel, open Speech.

Starting speech recognition
After you have set up speech recognition, you can start it from Input Panel.

To start speech recognition
2. Tap the Tools and Options button ( ), then tap Speech.
3. Select Dictation or Commands.

For more information about Dictation and Commands, see the Input Panel Help and the Tablet PC Tutorials.

Using power management
The LE1700 includes a comprehensive suite of power management functions. By using Motion Dashboard, you can control the following:

- Power schemes
- Alarms for low and critical battery
- Power meter readings for up to two batteries
- Advanced power settings
- Hibernation settings

Power Schemes
Use the Power Schemes tab to select from a set of pre-defined power schemes that are appropriate for various computing environments. You can also define your own scheme, or save one to another name that makes more sense to you.
Alarms
Use the Alarms tab to specify the point at which battery alarms are activated for the low and critically low battery level states. You can also define what happens when that battery level is reached. For example, you may choose to have the tablet sound an alarm, or you may prefer to receive a visual reminder.

Power Meter
Use the Power Meter tab to see a visual indication of the power status. If you select the Show Details option, you can tap a battery icon for more information.

Advanced
Use the Advanced tab to define the power-saving settings that you want to use. You can specify what you want the Tablet PC to do when you press the Power switch.

Hibernate
Use the Hibernate tab enable or disable hibernation. This tab also shows information about the disk space used for hibernation. To use Hibernation, see “Using Hibernate” on page 31.

To manage power settings
1. Open Motion Dashboard to the Power panel (page 20).
2. Tap the Power Options button.

The following illustration shows the window open to the Power Schemes tab, which defines the power settings for the Tablet PC.
Using Standby
Standby is a state in which your display and hard disks turn off, so that your computer uses less power. When you want to use the computer again, it comes out of standby quickly, although you may have to log on again.

Use standby to save power when you will be away from the computer for a short time while working. Because Standby does not save your desktop state to disk, a power failure while on Standby can cause you to lose unsaved information.

To put your computer on Standby
1. Open Motion Dashboard to the Power panel (page 20).
2. For Power Button, select Standby.
3. To put your computer on Standby, slide the power switch.

To turn your computer back on, slide the power switch.

Using Hibernate
Hibernate is a state in which your computer shuts down to save power but first saves everything in memory to the hard disk drive. When you restart the computer, your desktop is restored exactly as you left it. Use hibernation to save power when you will be away from the computer for an extended time.

Hibernate has the following advantages over Standby:
• Hibernate saves the state of the desktop and applications.
• Hibernate consumes no battery power.
• When you return from the Hibernate state, you return to where you were when you entered hibernation.

To enable Hibernate
1. Open Motion Dashboard to the Power panel (page 20).
2. Tap the Power Options button.
3. In the Power Options Properties window, tap the Hibernate tab.
4. Select Enable Hibernation.

To put your computer on Hibernate
1. Ensure that Hibernate is enabled.
2. Open Motion Dashboard to the Power panel (page 20).
3. For Power Button, select Hibernate.
4. To put your computer on Hibernate, slide the power switch.

To turn your computer back on, slide the power switch.
Using the battery
The Tablet PC runs on battery power when it is not plugged in. The standard battery, included with the Tablet PC, attaches to the top of the unit. To increase your battery life, you can also attach the optional extended battery. For more information, go to the Motion Computing accessories page at www.motioncomputing.com/accessories.

Checking battery power
You can check the remaining battery power from Motion Dashboard, from the battery icon in the notification area, or from the battery itself.

To check the remaining battery power
• Open Motion Dashboard to the Power panel (page 20).

You can also place the pointer over the battery icon in the notification area. The battery icon provides a graphical representation of the remaining battery power. If a standard battery and extended battery are both attached, the power reading is the cumulative charge of both batteries.

For the standard battery, you can check the remaining battery power from the battery itself, although you have to remove the battery to do so. For the extended battery, you can check the battery gauge without removing the battery.

To check the battery gauge
1. Remove the battery (page 33).
2. Locate the gauge on the battery and press the button. The indicator lights show the remaining charge. Each light represents approximately 20% of the available charge.

Charging the battery
When the Tablet PC (with a standard battery) is connected to AC power, the battery automatically charges until it reaches full charge, even if the Tablet PC is being used.

If two batteries (standard battery and extended battery) are attached, the standard battery charges first, then the extended battery. The charging sequence is staggered to ensure that both batteries become fully charged at nearly the same time. The standard battery charges to the 95% level, followed by the extended battery charging to the 95% level. Then each battery charges for a short interval until both reach 100%. When running on battery power, the extended battery discharges first, then the standard battery.

For information about the battery status light, see “Status lights” on page 10.

CAUTION: To avoid injury, keep the battery within the recommended temperature range while it is charging. If the battery has been subjected to a hot environment, wait until it cools to room temperature before recharging it. For more information, see the Safety and Regulatory Guide included with the Tablet PC.
Battery and power management tips

- To lengthen the battery's usable life, use AC power when you can. The battery will charge automatically while you run on AC power, so leave the battery in the tablet while you are working.
- For optimal battery life, use AC power when using a CD or DVD player.
- When running on battery power, place the system in Hibernate or Standby mode if you are going to leave it unattended for more than a few minutes (page 31).
- Remember that the display, processor, PC Cards, SD cards, wireless cards, and accessory drives all draw on the battery, so adjust properties and disable unused accessories while running on battery power.
- When running on battery power, adjust the display brightness to a dimmer setting and enable Dynamic brightness. See “Adjusting the display brightness” on page 24.
- Turn off wireless devices when they are not being used.

Removing and replacing the battery

You can remove the battery to check the remaining power, or to replace it with a fully charged battery.

**To remove the battery**

1. Ensure that the Tablet PC is plugged in or turned off.
2. Turn the Tablet PC over so that the back side is up.
3. Slide the locking latch toward the center of the battery to unlock it.
4. Slide the spring-loaded latch toward the center of the battery and hold it while you remove the battery.

**To replace the battery**

1. Slide the spring-loaded latch toward the center of the battery and hold it while you insert the battery down into the Tablet PC.
2. Release the spring-loaded latch.
3. Slide the locking latch toward the outside of the battery to lock it.
Swapping the battery
You can swap the standard battery while the system is on, with or without having the Tablet PC plugged in to AC power.

To swap batteries
1. Put the computer in Hibernate or Standby mode (page 31).
   • With Standby, the Tablet PC will maintain your system for up to 30 seconds while you swap the battery. You may have less than 30 seconds if you have many applications running.
   • With Hibernate, you will have as long as you need to swap the battery.
2. Remove the battery (page 33).
3. Insert the new battery (page 34).

Important: Use only Motion Computing LE-Series batteries with the LE-Series Tablet PC.

Battery maintenance
To maximize the performance of the tablet’s primary battery or Extended Battery, deplete each battery’s charge level to less than 10% every 30 days. To deplete the charge, install the Battery on the tablet and use the tablet without AC power until the battery charge is depleted to less than 10%. Verify the status of your battery using the battery icon in the notification area of your tablet desktop. See “Checking battery power” on page 32.

Long-term battery storage (not attached to tablet)
Do not store any batteries with a full charge; this can cause a permanent loss of charging capacity. For long-term storage, the battery should be charged to a level between 20% and 40% (two contiguous LEDs illuminated) of a full charge. Stored batteries should be checked every 90 days to determine the charge status. If only one LED or no LED is illuminated, recharge the batteries to a level between 20% and 40%.

For optimum care, store the battery in a cool, dry environment. Never expose the battery to temperatures above 60°C (140°F).

Note: In storage, the batteries will self-discharge at a rate of 10% of the total capacity per month.
Battery fault code
To check the battery status, push the button next to the LEDs. If the top, middle, and bottom LEDs on the battery illuminate simultaneously, the battery has failed and must be replaced.

Disposing of used batteries
When Lithium-ion (Li-ion) batteries are no longer serviceable, the batteries should be sent to a hazardous materials recycling center. Do not discard the batteries in a waste receptacle because they could be sent to a landfill.

Extended Battery Self-Conditioning
The new LE-Series Extended Battery includes a self-conditioning mode that can help maximize the battery’s capacity and life span.

Battery self-conditioning prevents the Extended Battery from charging if the charge level has not depleted to less than 25% in the previous 30 days.

To complete the self-conditioning cycle, use the Tablet PC without an AC-power adapter, until the Extended Battery charge drops to below 25%.

If your Tablet PC has the self-conditioning capability, you will be notified with a pop-up window when your Extended Battery goes into self-conditioning mode.

Troubleshooting the Extended Battery

The battery status light on the Tablet PC is glowing amber, which indicates that the Extended Battery is charging, but the battery does not charge.

- The system BIOS and Motion Dashboard may be out of date. Download the latest drivers and BIOS from [www.motioncomputing.com/support](http://www.motioncomputing.com/support).
The battery status light on the Tablet PC is blinking amber when the Extended Battery is installed and AC power is applied to the tablet.

- The Extended Battery may have failed. Use the status lights on the Extended Battery to verify its condition.

If the three LEDs (indicated with arrows) are illuminated, the battery has failed and must be replaced.

- The Extended Battery is in self-conditioning mode. Allow the battery to deplete its charge to less than 25%.

The Tablet PC does not start correctly while the Extended Battery is in self-conditioning mode.

- The system BIOS and Motion Dashboard may be out of date. Download the latest drivers and BIOS from www.motioncomputing.com/support.
- The Extended Battery is in self-conditioning mode. Allow the battery to deplete its charge to less than 25%.
Using Motion OmniPass and the fingerprint reader
Motion OmniPass offers a secure and convenient system for managing your passwords and providing confidentiality for your sensitive data through file encryption.

To start Motion OmniPass

- In the notification area, double-tap the Motion OmniPass icon ( ).

You can also start Motion OmniPass from the Security panel of Motion Dashboard.

The following illustration shows the Motion OmniPass Control Center.

From the OmniPass Control Center, you can manage OmniPass users and settings (distinct from Windows users), change OmniPass settings, manage passwords, and protect your files. For more information, see the OmniPass Help.

Capturing a fingerprint
After you capture your fingerprints, you can associate the fingerprints with an OmniPass user. This offers a quick and convenient way to log on to your Tablet PC, provides global password management, and helps protect your data from unauthorized access.

Use this procedure to enroll a new user and capture a fingerprint for authentication.

To capture a fingerprint

1. Start Motion OmniPass (page 37) and tap Run Enrollment Wizard.
2. Enter the Windows account information for the new user and tap Next. The fields may default to the user name of the current user.
3. If you are prompted to select an authentication device, select Fingerprint Device.
4. In the Choose Finger window, tap on the finger you want to enroll, then tap **Next** or **Practice**. Practice allows you to do a trial run of the fingerprint capture.

5. Place the selected finger over the fingerprint reader and slowly drag your finger across the sensor from right to left or left to right.

   If the capture is successful, a green fingerprint image will appear in the capture area. If the capture is unsuccessful, follow the instructions on the screen to improve the scan.

   After you have successfully captured your fingerprint, scan your fingerprint one more time for verification.

6. Tap **Next**, then tap **Yes** if you want to enroll a second fingerprint (recommended). If you injure a finger, you can use a second finger to authenticate.
You can also capture a second fingerprint later. From the OmniPass Control Center, tap **Run Enrollment Wizard**, then tap **Modify a user's device enrollment**.

7. Select **I am done with enrolling security authentication devices** and tap **Next**.

8. Select your user preferences and tap **Next**. On the Backup User Profile screen, tap **Backup Now**.

9. Select a location for your backup profile and tap **Save**. Enter a password and tap **OK**. On the final screen, tap **Done**.

You should keep your backup profile in a secure location, such as on an external drive that you can remove and store in a secure environment.

If your profile is lost or corrupted, you can restore it later. You should back up your profile periodically to protect your configuration and any stored passwords and encryption keys. For more information, see the OmniPass Help.

**Fingerprint reader tips**

- Be consistent. Hold your finger and scan at the same angle each time. For example, if you enroll your finger with your hand open, hold your hand this way each time you scan.
- The scanner is bi-directional. You can move your finger from right to left or left to right.
- Read the prompts carefully and ensure that you wait for the prompt before you swipe.
- Swiping too fast or too slow can make a capture unsuccessful. Change the swipe speed until you learn what speed works best.
- When scanning, press hard enough to fully contact both the nickel-colored ring and the sensor; you do not have to press hard.
- Rub your fingers together to stimulate the natural skin oils so your fingerprint is easier to detect. Conversely, wipe your finger off so nothing interferes with the scan.
- If you are having trouble enrolling a specific finger, enroll a different finger. Typically, you should scan an index finger, thumb, middle finger, ring finger, and little finger in that order.
- If you are repeatedly having trouble getting a good scan, you may need to clean the sensor. See “Cleaning the fingerprint reader” on page 56.

**Using password replacement**

OmniPass can manage your passwords for other applications, such as Web sites, Internet email, FTP, or any restricted-access network resource. After OmniPass registers your credentials, you can access any of these restricted areas by using your fingerprint or the master password.

**To register passwords**

1. When you encounter a user name and password prompt, enter your user name and password, but do not log on. (Do not tap **Enter**, **Submit**, or **OK**.)

2. Right-click the OmniPass icon, and select **Remember Password**. The Windows arrow pointer changes to the OmniPass golden key.

3. Click the key cursor on the window that has the password that you want OmniPass to remember.
4. Enter the following information:
   - **Friendly Name.** A descriptive name to identify the password box.
   - **Automatically enter.** Instantly accesses the site without requiring a password or fingerprint scan. If you are logged in to OmniPass and you access a secure Web site, OmniPass will automatically submit your user name and password without prompting for verification.
   - **Automatically click.** Prompts you for your OmniPass/Windows password or fingerprint scan when you access the site (default).

5. Tap **Finish**.

6. If prompted, swipe your fingerprint or enter your master password to authenticate these settings.

**Using the password wizard**

Certain applications require more sophisticated user input for authentication. For these applications, you may need to use the password wizard to set up password replacement.

**To run the password wizard**

1. Start Motion OmniPass (page 37).
2. In the left pane, tap **Password Wizard**.
3. Follow the instructions in the wizard program.

**Logging on to a remembered site**

To log on to a remembered site, open the Web site or application that you have set up with password replacement. See “Using password replacement” on page 39. Swipe your finger or enter the master password when prompted.

To remove a remembered site, tap **Manage Passwords**.

**Setting up a smart card device**

Before you start this procedure you should have already enrolled as an OmniPass user. To enroll as an OmniPass user with the fingerprint reader device, see “Capturing a fingerprint” on page 37.

To set up a smart card, you must purchase a smart card reader separately. For more information, go to the Motion Computing accessories page at [www.motioncomputing.com/accessories](http://www.motioncomputing.com/accessories).

**To set up a smart card device**

1. Install the card reader according to the manufacturer’s instructions.
2. Start Motion OmniPass (page 37).
3. Tap **Run Enrollment Wizard**.
4. Tap *Modify a user’s device enrollment*. If prompted, authenticate with OmniPass.

5. Select *SmartCard* and tap *Next*. Insert the smart card into the smart card reader if you have not done so already.

6. Enter the PIN for the smart card.

7. On the confirmation screen, tap *Next*.

8. On the Device Enrollment Complete screen, select *I am done with enrolling devices* and tap *Next*. 
Setting up strong logon security

For an additional level of security, you can enable strong logon security. Strong logon security forces you to authenticate with a specific security device (such as the fingerprint reader or a Smart Card) before allowing access to Windows.

After strong logon security is enabled, the Windows Welcome screen and Windows Fast User Switching are disabled.

To enable strong logon security
1. Start Motion OmniPass (page 37).
2. Tap the Change Your System Settings tab.
3. Select the Enable strong logon security check box.
4. Tap Save all changes.
5. Tap OK and restart your computer.

After you restart your computer, you should configure the authentication rules for strong logon security.

To configure authentication rules
1. Start Motion OmniPass (page 37).
2. Tap Change Your User Settings.
3. Tap Set user authentication rules and policies.
4. Select the appropriate authentication rules.
5. Tap OK.
Using Windows Security Center

Windows Security Center provides a central location for you to manage your computer’s security settings and learn more about improving security. If a problem is detected (such as an out-of-date antivirus application), the Security Center sends you an alert and provides recommendations for how to remedy the situation.

Windows Security Center manages the following:

- **Windows Firewall.** Protects your computer against viruses and other security threats, such as intruders who might try access over the Internet or a network.

- **Automatic Updates.** Keeps your computer up to date by notifying you of important Windows updates. You can configure Automatic Updates to download and install updates automatically.

- **Internet Options.** Protects you from Web sites that could damage your computer, blocks pop-ups, and protects your privacy. Internet Options allow you to change the settings of Internet Explorer, but it cannot be used to change the settings of other Web browsers.

To learn more about Windows Security Center, open Motion Dashboard to the Security panel, then tap **Windows Security Center**.
Setting up users and passwords
You can use different types of user accounts and passwords to create various levels of protection for your Tablet PC and its data, depending on the level of security that you need.

Setting up Windows user accounts
You can use Windows user accounts to help secure the files on your computer from other users. You must have an administrator account on the computer to add a new user to the computer.

To set up a Windows user account
1. In Control Panel, open User Accounts.
2. Tap Create a new account.
3. Enter the appropriate information for the new user account.

Setting a BIOS password
You can use a BIOS password to secure the basic input/output system of the computer.

WARNING: Read this section carefully to understand the implications of creating a BIOS system password. If you forget the password, you will not be able to access your Tablet PC. If this happens, contact Motion Computing Technical Support at www.motioncomputing.com/support. Have your serial number ready. You can find the serial number on the back of the Tablet PC.

To set a BIOS password
1. Start the Tablet PC.
2. When the Motion Computing splash screen appears, press the Rotate button ( ). If you miss the splash screen, restart the computer and try again. If you have a keyboard attached, you can press the F2 key or the Rotate button.
3. Quickly tap the screen with the tablet pen to open the system setup menu. If you have a keyboard attached, you can also press the space bar to open the system setup menu.
4. Tap Password Options.
5. In the Password window, select Change current password and enter a password using the on-screen keyboard.
6. Select Enable password on boot, if desired.
   A BIOS password requires the user to enter a password to open the BIOS. A password on boot requires the user to enter a password to start the computer.
7. Tap OK.

To clear the password, select Change current password, leave the password fields blank, then tap OK.
Setting up a hard disk drive (HDD) password
You can use a HDD password to protect the computer and the hard disk drive. The computer cannot be started without the HDD password, and the data on the disk drive cannot be accessed, even if it is removed and attached to a different computer.

To set up an HDD password
1. Start the Tablet PC.

2. When the Motion Computing splash screen appears, press the Rotate button ( ). If you miss the splash screen, restart the computer and try again. If you have a keyboard attached, you can press the F2 key or the Rotate button.


4. Tap Enter for Set Hard Disk Password.

5. Enter a password using the on-screen keyboard and tap Enter. Enter the password again to confirm it and tap Enter.

6. Tap Exit, then select Exit Saving Changes.

To clear the password, double-tap Enter for Set Hard Disk Password. Enter the current password, then tap Enter twice to leave the Enter New Password fields blank.
Using Wi-Fi (802.11a/b/g)

Use the information in this section to set up a Wi-Fi connection. Wireless access requires an 802.11a, 802.11b, or 802.11g access point. Internet access requires a working Internet connection.

**DANGER:** FAA regulations require that you disable any wireless connection when traveling by air. Failure to disable the wireless connection on the Tablet PC while traveling by air can cause communications problems with aircraft instruments.

Enabling or disabling Wi-Fi

Before you can establish a Wi-Fi connection, you must enable the Wi-Fi adapter. You can enable the Wi-Fi adapter using Motion Dashboard.

**To enable or disable Wi-Fi**

1. Open the Motion Dashboard to the Wireless panel (page 20).
2. Select or clear the **Enable Internal 802.11 Wireless** check box.

Setting up a Wi-Fi connection

Use this procedure to create a Wi-Fi connection.

**To set up a Wi-Fi connection**

1. Open the Motion Dashboard to the Wireless panel (page 20).
2. Ensure that **Enable Internal 802.11 Wireless** is selected.
3. Tap the **Properties** button.
4. In the Network Connection Properties window, tap **View Available Wireless Networks**.
5. Select the network you want to connect to and tap **Connect**. If you are connecting to a secure network, you may need to enter authentication information.

For more information about Wi-Fi, see “Wi-Fi (802.11a/b/g wireless)” on page 16.
Using Wireless Broadband

Use the information in this section to set up a Wireless Broadband connection. Wireless Broadband access requires a service contract from a Wireless Broadband service provider.

For more information, see “Wireless Broadband” on page 16.

**WARNING:** FAA regulations require that you disable any wireless connection when traveling by air. Failure to disable the wireless connection on the Tablet PC while traveling by air can cause communications problems with aircraft instruments.

Activating your Wireless Broadband service

Before you can use the Wireless Broadband service, you must activate your service with the service provider you chose when you ordered your Tablet PC.

You may be able to activate your service using the connection manager, or you may have to call your service provider to activate. For more information about starting the connection manager, see the Wireless Broadband document in the Tablet PC box.

Enabling Wireless Broadband

Before you can establish a Wireless Broadband connection, you must enable the Wireless Broadband adapter. You can enable the Wireless Broadband adapter using Motion Dashboard.

**To enable Wireless Broadband**

1. Open the Motion Dashboard to the Wireless panel (page 20).
2. Select the **Enable Broadband Wireless** check box.

Starting the connection manager

The connection manager software is preinstalled on your Tablet PC based on the service provider you chose when you ordered the Tablet PC.

**To start the connection manager**

- Double-tap the connection manager shortcut on your desktop.

For more information, see the connection manager help.

*Note:* The connection manager software you use depends on your wireless service provider. For more information, see the Wireless Broadband document in the Tablet PC box.
Connecting and disconnecting
Use the connection manager software to connect to your provider’s Wireless Broadband network.

**To connect and disconnect**
1. Start the connection manager (page 47).
2. Do one of the following:
   - To connect, click **Connect** or **Go**.
   - To disconnect, click **Disconnect** or **Stop**.

Using Bluetooth
You can use Bluetooth® to connect to accessory devices or other computers. The devices can communicate with each other when they are in range. For more information, see “Bluetooth wireless” on page 16.

Enabling or disabling Bluetooth
Before you can set up a Bluetooth device, you must enable the Bluetooth adapter on the Tablet PC. After you enable Bluetooth, the Bluetooth icon ( ) appears in the notification area. You can tap on this icon to get shortcuts to the Bluetooth Settings window, the Bluetooth File Transfer Wizard, and the Add New Connection Wizard.

**To enable or disable Bluetooth**
1. Open Motion Dashboard to the Wireless panel (page 20).
2. Select or clear **Enable Internal Bluetooth Wireless**.

After you enable Bluetooth, the Bluetooth adapter tries to discover other Bluetooth devices within range. When a Bluetooth device is discoverable, it is visible to other Bluetooth devices in range. For information about making a device discoverable, see the device’s documentation.

Setting up a Bluetooth device
Before you can use a Bluetooth device with your Tablet PC, you need to set up the device. After you set up the device, it is paired with your Tablet PC, and uses a passkey to create a secure connection between the Tablet PC and the Bluetooth device.

*Note:* Although the passkey exchange helps to secure your data, Bluetooth wireless technology should not be considered completely secure.

**To set up a Bluetooth connection**
1. Ensure that Bluetooth is enabled.
2. Tap **Start** > **All Programs** > **Bluetooth** > **Bluetooth Settings** to open the Bluetooth Settings window.
3. Place the Bluetooth device in discoverable mode. Each Bluetooth device may have a different way to make it discoverable. See the manufacturer’s documentation for more information.

4. Tap the **New Connection** button.

5. In the Add New Connection window, select **Express** and tap **Next**.

6. Under Bluetooth devices, select the appropriate device and tap **Next**. If the device is not discovered, see “If the device is not discovered…” on page 49.

7. If required, enter the number shown in the Passkey field and press **Enter**. See the manufacturer’s documentation for more information.

8. Enter a name for the device and tap **Next**. After the Bluetooth installation finishes, tap **Finish**.

The Bluetooth device is ready to use. Paired devices are shown in the Bluetooth Settings window. The following illustration shows a Bluetooth Settings window with a Bluetooth keyboard and mouse.

![Bluetooth Settings](image)

If the device is not discovered…

If the Bluetooth device is not detected after multiple attempts, try the following:

- Ensure that Bluetooth is enabled (page 48).
- Ensure that the device you are adding is discoverable. See the manufacturer’s documentation for more information.
- Ensure that the Bluetooth device has good batteries.
- For keyboards, mice, and printers, ensure that you select **My device is set up and ready to be found** in the Add Bluetooth Device Wizard.
- For Tablet PCs transferring files, both tablets must turn on the device transfer wizard, although only the receiving Tablet PC needs to be discoverable. Tap the Bluetooth icon
and then **Send a file** or **Receive a file**. When you do this, discovery is automatically turned on for the receiving device.

- Select **Allow Bluetooth devices to connect to this computer** to connect to keyboards, mice, printers, and other devices. You find this by right-clicking the Bluetooth icon > Show Bluetooth Devices > Options.
- Check which Bluetooth devices are connected. Tap the Bluetooth Devices icon > Open Bluetooth Settings. On the Devices window, you should be able to see Bluetooth devices that are currently connected.

If the Tablet PC still cannot detect the Bluetooth device, contact the device manufacturer for assistance.

**Bluetooth wireless tips**

Motion Computing and its Bluetooth partners have worked to ensure a positive experience with this technology, and to ensure Bluetooth interoperability. In doing so, we have found the following issues:

- If you are running Bluetooth and Wi-Fi at the same time, interference can affect the Bluetooth performance. This is most noticeable when you try to transfer large amounts of data, such as file transfers or printing large documents. This may also be noticeable when you try to transfer large or small amounts of data may if several Bluetooth devices are operating simultaneously in an office.
- Bluetooth audio has not been fully developed for speech recognition. Therefore, for speech recognition, we recommend that you not use a Bluetooth wireless headset. Moreover, Motion Speak Anywhere can record clear audio, dictate notes, and use voice commands without a microphone headset.
- Some Bluetooth devices will disconnect when they go into power-saving mode. Most devices will automatically reconnect when they become active again.
- If you attempt to install other wireless headset or other audio drivers (such as Bluetooth or USB) over the Tablet PC audio drivers, a malfunction of the Tablet PC audio system may occur because the drivers may not be compatible.
- Occasionally, some Bluetooth device compatibility issues can occur. If you are having problems with interoperability of Bluetooth devices, contact the manufacturer of your Bluetooth device and check its compatibility with the Bluetooth software installed on your Tablet PC.
- Your Tablet PC comes with Bluetooth software from Toshiba, although you can use other Bluetooth software. For more information, go to the Motion Computing Knowledge Base at [http://www.motioncomputing.com/kb](http://www.motioncomputing.com/kb) and search for “Bluetooth”.
Using infrared
You can use infrared to connect to printers, modems, cellular phones, and other devices. Use the Wireless Link window to control infrared connections.

To open the Wireless Link window
• In Control Panel, open Wireless Link.

To establish an infrared connection
1. Ensure that infrared is enabled on both devices.

2. Position the devices so that the two infrared transceivers are pointing at each other, and the devices are within one meter of each other.

   When the devices establish a connection, the Infrared icon ( ) appears in the notification area.

3. Double-tap the Infrared icon.

   Depending on the type of device, you can send or receive files, connect to a printer, or access the Internet.

4. Follow the instructions in the Wireless Link program.

Finding additional software
For information about other tablet-oriented software, go to the Motion Computing software page at www.motioncomputing.com/products/software_motion.asp.

You will find links to software solutions for purchase as well as free downloads from Motion software and service partners.
Proper care and maintenance will keep your Tablet PC working and in good condition for a long time. For general information about care of the Tablet PC and its components and accessories, see the Safety and Regulatory Guide included with your Tablet PC.

This chapter describes the care and maintenance procedures for your LE1700 Tablet PC.

**Important:** Follow the guidelines listed below when caring for your Tablet PC and its components. Improper use may damage the Tablet PC and its components and void the warranty.

**General care**

- Protect the Tablet PC from exposure to extreme temperatures, shock, liquids, and strong magnetic fields.
- If you are storing the Tablet PC for a long time, unplug the power adapter and remove the battery after partially discharging it.
- Do not place heavy objects on top of the Tablet PC.
- Do not open the Tablet PC case except to replace Motion-authorized components. Always follow the instructions included with these accessories when performing these procedures.
Standard display

- Clean fingerprints and most marks from the display surface by wiping it with the soft cloth (provided). Never spray or pour liquids directly onto the display surface itself. Never use an abrasive cleaner on the display. If liquid is spilled on the display, wipe it up immediately.
- If needed, spray a soft cloth (not directly on the display) with a window-type cleaner and wipe the display.
- Avoid using tissues or paper towels to clean the display surface. These contain wood fibers that can scratch the display.
- Use only the tablet pen on the display. Do not write on the display with an ink pen or pencil, or any other object that could damage the display surface.
- Protect the display surface from unnecessary contact by using a case when transporting the Tablet PC.
- Avoid exposing the display to direct sunlight for long periods of time.

View Anywhere display

- Clean fingerprints and most marks from the display surface by wiping it with the soft cloth (provided). Never spray or pour liquids directly onto the display surface itself. Never use an abrasive cleaner on the display. If liquid is spilled on the display, wipe it up immediately.
- If needed, clean with any alcohol-based product recommended for anti-reflective glass. Other cleaning products might leave a residue.
- Avoid using tissues or paper towels to clean the display surface. These contain wood fibers that can scratch the display.
- Use only the tablet pen on the display. Do not write on the display with an ink pen or pencil, or any other object that could damage the display.
- Protect the display surface from unnecessary contact by using a case when transporting the Tablet PC.
- Avoid exposing the display to direct sunlight for long periods of time.
Cleaning in a health care environment
This section describes the cleaning procedures for a Tablet PC in a health care environment.

Disinfecting procedures
You should periodically disinfect the tablet according to the institutional policies of surface and equipment safety and cleanliness.

According to the Centers for Disease Control, “items that do not ordinarily touch the patient or touch only intact skin are not involved in disease transmission, and generally do not necessitate disinfection between uses on different patients.”¹ We recommend using an EPA-approved low-level disinfectant when general cleaning is required. For a list of cleaning solutions tested by Motion Computing, see “Cleaning solutions” on page 56.

If the tablet becomes soiled with blood or other body fluids, chemical germicides that are EPA-approved for use as hospital disinfectants and that are tuberculocidal/virucidal when used at recommended dilutions and contact times can be used. Visibly soiled areas should first be cleaned and then chemically decontaminated. For disinfection, the cleaned areas should be moistened with the appropriate germicide and allowed to air dry.²

If a tablet is used with patients who are infected or colonized with vancomycin-resistant enterococci or other drug-resistant microorganisms judged by the infection control program (based on current state, regional, or national recommendations, to be of special or clinical or epidemiologic significance or with highly virulent microorganisms such as Ebola or Lassa), then the tablet should be dedicated to one patient or patient cohort or subjected to low-level disinfection between patient uses.¹

Training and documentation considerations
All users of Motion Tablet PCs in the health care environment should be provided with training on proper cleaning procedures. Cleaning procedures should be added to the institution’s policies and procedures for infection control.

---

Cleaning solutions
This section describes various cleaning solutions that have been tested by Motion Computing. Please review the manufacturer's guidelines for proper use of the product.

<table>
<thead>
<tr>
<th>Product Type</th>
<th>Manufacturer</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alcohol Prep Pads</td>
<td>Dynarex</td>
<td>For general purpose use only. Not considered a disinfectant for health care environments.</td>
</tr>
<tr>
<td>Cavi-Wipes</td>
<td>Metrex</td>
<td>Can be difficult to clean off. Can leave a film on the product.</td>
</tr>
<tr>
<td>Germicidal Wipes (Super Sani-Cloth)</td>
<td>PDI</td>
<td>Requires gloves for use and can be difficult to clean off. Effective on acrylic displays but can be difficult to clean off the ViewAnywhere display.</td>
</tr>
<tr>
<td>MOC Reviver</td>
<td>MOC</td>
<td>Can be difficult to clean off. Can leave a film on the product.</td>
</tr>
<tr>
<td>PVP-I Prep Pads</td>
<td>Triad</td>
<td>Can leave a yellow film on the product.</td>
</tr>
<tr>
<td>Sani-Cloth</td>
<td>PDI</td>
<td>Requires gloves for use and can be difficult to clean off.</td>
</tr>
<tr>
<td>Screen Cleaner</td>
<td>Office Depot</td>
<td>For general purpose use only. Not considered a disinfectant for health care environments.</td>
</tr>
<tr>
<td>Vira-Guard</td>
<td>Veridien</td>
<td>Highly recommended.</td>
</tr>
<tr>
<td>Virex</td>
<td>Virex</td>
<td>Can be difficult to clean off. Can leave a film on the product.</td>
</tr>
</tbody>
</table>

Cleaning the fingerprint reader
Under normal circumstances, you should clean the fingerprint reader once a month, or whenever necessary.

**To clean the fingerprint reader**
1. Shut down the Tablet PC, unplug it, and remove the battery.
2. Lightly spray a cotton swab with household window cleaner.
3. Gently rub the sensor surface with the cotton swab, slowly rotating the swab so a new, clean surface of the swab is constantly exposed to the sensor surface. Do not allow cleaner to drip or run down into the electronics around the sensor.
   
   Do not use bleach, solvents, or abrasives. Do not spray or pour any liquid directly on the sensor.
4. After cleaning, gently rub the surfaces again with a clean, dry cotton swab. Use a clean swab each time you clean the sensor.
Pen

- Store the pen in the pen bay or in a case when not in use.
- Do not store the pen vertically on the tip. Constant pressure on the tip can affect the pen-to-digitizer interaction.
- Change the pen tip regularly. See “Replacing pen tips” on page 57.
- Do not immerse the pen in liquid. It contains electronic components that could be damaged.
- In certain environments, particles or debris can stick to the pen tip or the Tablet PC display. To avoid damaging the display, clean it frequently with the provided cleaning cloth. Also, change pen tips regularly, especially if you drop the pen onto a rough surface that could damage the tip or embed debris in it. Damaged pen tips can scratch the display.

Replacing pen tips
Pen tips eventually wear down or get damaged, so the pen includes extra tips and a tool for replacing them.

With typical use, you should change the pen tip every 90 days. If you use the pen in a dirty environment, you should change the pen tip every 30 days. Particles can become embedded in the pen tip and scratch the display.

To replace the pen tip
1. Grasp the old tip with the tip replacement tool. Use the notch on the ring to grab the tip.
2. Pull the old tip out of the pen.
3. Insert a new tip.
4. Apply slight pressure to push it into place.

Ordering new pens
To order additional pens, go to the Motion Computing accessories page at www.motioncomputing.com/accessories.
Replacing the antenna
If the antenna becomes detached from the Tablet PC, you can snap it back in to place.

If the antenna breaks, you can order another one from Motion Computing. Go to the Motion Computing accessories page at www.motioncomputing.com/accessories.

Traveling with your Tablet PC
Use the following tips when you travel with your Tablet PC:

• Remove all accessories and cables. Remember to pack those you will need while traveling, including at least one tablet pen.
• Put the Tablet PC into a portfolio or other case to protect the display.
• Protect the pen by keeping it in the pen bay or in a case during travel.
• Pack the Tablet PC securely in a briefcase or hand-carried luggage, and keep it separate from toiletries, liquids, and food. Do not pack it in checked luggage.
• Keep the Tablet PC stable during travel. Secure it to prevent it from sliding around in overhead bins and car trunks.
• Before extended use in the field or long trips away from AC power, adjust the power properties to maximize battery conservation. You can adjust the power properties from Motion Dashboard. See “Using power management” on page 29.
• For international travel, obtain and use the appropriate adapters for your destination’s electrical outlets. A current converter is not necessary.
• You may want to carry proof of ownership or a merchandise passport when traveling internationally.
• Consult your insurance company and credit card company to learn about emergency travel assistance in case your Tablet PC becomes lost or disabled.
Traveling by air
Use the following tips when traveling by air.

- Have a fully charged battery in case security personnel ask you to start the Tablet PC.
- Have it hand-inspected or sent through the X-ray scanner, but never carry it through the metal detector.
- Turn off the Tablet PC off or place it in hibernation mode for takeoff and landing.

FAA Wireless air travel requirement
The FAA requires that you suspend wireless operations, such as Wi-Fi and Bluetooth, before boarding a plane. You can disable all wireless by pressing the Wireless power button for a half-second.

To disable external wireless, remove any wireless PC cards. Failure to suspend wireless operations while traveling by air can cause problems with aircraft instruments.

DANGER: Do not transport Li-ion batteries in checked baggage. The baggage hold can get very hot, which can overheat the Li-ion battery and result in an explosion. You can take up to two spare batteries in carry-on luggage, in addition to the one in your Tablet PC. Transporting batteries in checked baggage or transporting more than two spare batteries is a violation of federal transportation regulations.

Restoring data
You can use the Acronis True Image software to restore your computer to the state it was in when it left the factory. Additionally, you can create your own backup data archives and restore those later. For more information, see the Acronis True Image Help.

Using Acronis True Image in Windows
You can use Acronis True Image in Windows or from the boot menu. We recommend that you run Acronis True Image in Windows because the Windows version has more features.

To restore using Acronis True Image in Windows
1. Start Acronis True Image by double-tapping the Acronis True Image icon on your computer's desktop.
2. Tap Recovery.
3. Follow the instructions in the Restore Data Wizard. For more information, see the Acronis True Image Help.
Using Acronis Startup Recovery Manager
If you cannot start Windows, you can run Startup Recovery Manager when you start the computer. If the operating system will not start, you can use Startup Recovery Manager to restore damaged partitions.

To restore from the Startup Recovery Manager
1. Start the LE1700 (page 5).
2. When the Acronis screen appears, press the Enter button (page 9) or the Enter key on the keyboard (optional).
3. Tap Start Acronis True Image.
4. Tap Recovery.
5. Follow the instructions in the Restore Data Wizard. For more information, see the Acronis True Image Help.

Creating a backup archive
If you want to roll back your system to a predetermined state, you can create a backup archive.

To create a backup archive
1. Start Acronis True Image by double-tapping the Acronis True Image icon on your computer's desktop.
2. Tap Backup.
3. Follow the instructions in the Create Backup Archive Wizard. For more information, see the Acronis True Image Help.

Creating a bootable disk
You can create a bootable recovery disk that you can use if you are ever unable to start your computer.

Note: For this procedure, you need an external CD+-/RW drive, DVD+-/RW drive, or USB flash drive (16 MB or larger).

To create a bootable disk
1. Start Acronis True Image by double-tapping the Acronis True Image icon on your computer's desktop.
2. Tap Create Bootable Rescue Media.
3. Follow the instructions in the Bootable Rescue Media Builder. For more information, see the Acronis True Image Help.
Removing the Acronis OEM Zone

The Acronis OEM Zone is a special partition on the computer's hard disk drive that stores the original factory backup archive. If you have created your own hard disk drive backup archive and a bootable disk, you can delete the OEM zone to free up some disk space.

To remove the OEM Zone

1. Start Acronis True Image by double-tapping the Acronis True Image icon on your computer’s desktop.

2. Tap Remove Acronis OEM Zone.

3. Follow the instructions in the wizard. For more information, see the Acronis True Image Help.

**WARNING:** Removing the Acronis OEM Zone will disable Acronis Startup Recovery Manager and the original factory backup archive.
Motion Computing Tablet PCs are thoroughly tested for performance and quality, but occasionally problems still occur. If you do not find the information you are looking for in this section, go to the Motion Computing support page at www.motioncomputing.com/support.

Troubleshooting
Use the information in this section to identify and resolve common issues. If an issue has more than one potential cause, the most common cause is listed first.

Power

The computer does not turn on
• The power switch might not be fully engaged. Slide and hold the power switch for at least a half-second, but no more than three seconds.
• The computer might not be plugged in or battery might be depleted. Plug the computer in to AC power.

The computer does not shut down
• An application might have stopped responding. Use Task Manager to manually stop the application. (Press the Windows Security button and tap the Task Manager button.) For more information, open Windows Help and Support and search for “task manager”. You can also slide and hold the power switch for five seconds to force the computer to shut down.

The computer will not enter Hibernation mode.
• Hibernation might not be enabled. Use Motion Dashboard to enable Hibernation. See “Using Hibernate” on page 31.

The computer does not return from Hibernation while on battery power
• The battery might be depleted. Plug the computer in to AC power.
The display goes black while the Tablet PC is still turned on
• The computer might have turned off the display to save power. To restore the display, touch the screen with the tablet pen or press a button.
• The computer might have gone into Standby mode. In Standby mode, the power status light flashes blue. Slide and hold the power switch for about one second.
• The computer might have gone into low-battery Hibernation mode. In low-battery Hibernation mode, the power status light is off. Plug the computer in to AC power, then slide and hold the power switch for about one second.

Battery

The battery does not last very long (less than three hours)
• Hot or cold conditions can adversely affect the battery charge. Use AC power if you are operating the computer in these conditions.
• Accessory devices, such as a DVD player, and applications that make heavy use of the hard drive can drain the battery more quickly. Remove the accessory devices or use AC power if possible.
• The battery may be weakening. Use a different battery if possible. To order a new battery, go to www.motioncomputing.com/accessories.

I lost data while swapping batteries
• The computer will maintain data and settings for 30 seconds in Standby mode. This time may vary due to your system and the programs you are running. Try putting your computer into Hibernate mode before you swap batteries. See “Using Hibernate” on page 31.

Display

The desktop area is larger than the Tablet PC display
• If the display resolution is set higher than the display can support, the desktop area scrolls as you move around. Decrease the display resolution so that the entire desktop is visible. For more information, open Windows Help and Support and search for “change resolution”.

When I disconnect an external monitor, the desktop area is larger than the Tablet PC display
• The computer may have expanded the desktop beyond the display area of the Tablet PC display. Use Motion Dashboard to set the Tablet PC as the active display. For more information, see “Setting up an external display” on page 26.
  1. Open Motion Dashboard to the Display panel (page 20).
  2. Tap the Properties button
  3. Select Notebook to make the Tablet PC the primary display.

The display is too dim
• The brightness may be set too low. Use Motion Dashboard to increase the brightness. See “Adjusting the display brightness” on page 24.
The display is unreadable or distorted

- The screen resolution and color quality may be set incorrectly. Use Windows Display Properties to reset the display settings.
  1. In Control Panel, open Display.
  2. Click the Settings tab.
  3. For Screen resolution, select the appropriate resolution for your display (1024 × 768 for XGA displays or 1400 × 1050 for SXGA+ displays).
  4. For Color quality, select Highest (32 bit).
- The display driver may have been removed or become corrupted. Use Windows Device Manager to reinstall the driver.
  1. In Control Panel, open System.
  2. Open the Hardware tab, then tap Device Manager.
  3. Expand Display adapters.
  4. Select the adapter and select Action > Update driver.
  5. Follow the instructions in the setup program.

Input

The Tablet PC does not respond to the pen I am using

- You may be using an improper input device. Only Motion tablet pens can be used to write on the Tablet PC display. The Tablet PC does not respond to other pens or to a plastic stylus.
- You may be using the wrong tablet pen. Occasionally, a particular tablet pen may not work with a particular Tablet PC. If you are in an environment with multiple tablets and pens, try using a different pen. You can also tether the pen to the tablet to ensure that a pen stays with its tablet.

The pointer on the screen does not align with the tablet pen

- The pen may need to be calibrated. See “Calibrate the digitizer” on page 6.

When I write, I inadvertently click the function button on the pen

- Try adjusting how you hold the pen. Avoid resting your finger on the function button. You can use the Tablet and Pen Settings window to disable the button. See “Configuring pen options” on page 22.

The function button does not work

- The function button may not be enabled. You can use Tablet and Pen Settings window to enable the function button. See “Configuring pen options” on page 22.
- You may not be pressing the button early enough. Try pressing the function button before you touch the pen to the display surface.
The eraser does not work

- The eraser may not be enabled. You can use Tablet and Pen Settings window to enable the eraser. See “Configuring pen options” on page 22. The eraser works on ink only, not text.

The buttons on the Tablet PC do not do what I expect them to do

- The button functions may have been customized. You can use the Tablet and Pen Settings window to change the buttons to the desired functions. See “Configuring front panel buttons” on page 23.

Ports and connectors

The system does not recognize the PC card I inserted

- The card might be inserted improperly. Eject the card and re-insert it. Ensure the label side is up. See “PC card slot” on page 15.
- The device may not have been tested for Windows compatibility. For a list of tested products, go to the Windows Marketplace Tested Products page at www.microsoft.com/whdc/hcl.

The system does not recognize a USB device

- Windows may take a short time to recognize a USB device. Wait a few moments to see if Windows recognizes the device.
- The device may not be connected properly. Check the connection and ensure it is inserted properly into a USB port. You can also try a different port.
- The correct driver might not be included with Windows. Check the manufacturer’s Web site for a current driver, or use the installation CD that came with the device.

The Tablet PC is in its dock, but the system does not recognize any accessory devices, such as the external disk drive or monitor

- The Tablet PC may not be fully seated in the dock. Remove the Tablet PC from the dock and then replace it.

Network

The wireless adapter keeps connecting even when I do not want it to

- The wireless adapter is enabled. You can use Motion Dashboard to disable the wireless adapter. See “Enabling or disabling Wi-Fi” on page 46.

I cannot connect to a network using the Ethernet adapter

- The Ethernet cable may not be connected properly. Remove and reconnect the Ethernet cable or replace the cable.

Audio

No sound is coming from the built-in speakers

- Ensure that nothing is connected to the audio out port. Connecting headphones or external speakers disables the built-in speakers. Disconnect the headset or external speakers if not in use.
No sound is coming from any speakers

- The volume may be set too low or muted. You can use Motion Dashboard to increase the volume or turn mute off.
- The integrated audio components may have been overwritten. If you install a third-party audio device (such as a USB or Bluetooth device), the integrated audio may stop working. If this happens, reinstall the SigmaTel and Knowles Acoustics audio drivers. After you install these, if you still have problems recording, contact Motion Technical Support.

System

I forgot my BIOS password and cannot access my computer

- You can enter several incorrect passwords before the BIOS temporarily locks the system. You can try again by restarting the system. If you still cannot log on, contact Motion Computing Technical Support at www.motioncomputing.com/support.

An application has stopped responding, but I can still move the pointer and use other applications

- The application may have stopped responding. Use Task Manager to manually stop the application. (Press the Windows Security button and tap Task Manager.) See Windows Help and Support for more information.

The computer seems to be operating more slowly than usual

- The hard disk drive may be full or nearly full. You can use Disk Cleanup to free up space on your hard drive. For more information, open Windows Help and Support and search for “disk cleanup”.
- The hard disk may need to be defragmented. You can use Disk Defragmenter to consolidate files and folders on the hard drive. For more information, open Windows Help and Support and search for “disk defragmenter”.

Frequently asked questions

How can I make the battery charge last longer?

- For maximum conservation, you can use the Max Battery power scheme. To select this scheme, open Motion Dashboard to the Power panel.
- Use the Dynamic brightness display setting. This automatically controls the display brightness to conserve power. See “Adjusting the display brightness” on page 24.
- Set the display brightness to the dimmest level you are comfortable with. See “Adjusting the display brightness” on page 24.
- Disconnect any Ethernet connections that are not being used. Disable the wireless adapter and Bluetooth adapter if you are not using them. Disconnect unnecessary USB devices.
- Stop unnecessary background applications and processes.
What do I need to use the Tablet PC in another country?

- You will need a travel plug adapter. You can find these in airports and travel stores. You do not need to buy a voltage converter; the Motion AC adapter will automatically adjust to different voltages.

How do I clean the View Anywhere display screen?

- To clean the View Anywhere display screen, wipe it with a soft cloth (like the one supplied). If needed, clean with any alcohol-based product recommended for use on anti-reflective glass. Other cleaning products may leave a residue. Do not spray cleaners, spray/pour any liquid, nor wipe any abrasive cleaner on the screen nor any surface of the Tablet PC. Do not use tissues or paper towels to clean the screen. They contain wood fibers and may scratch the surface.

How do I clean the standard display screen?

- To clean the acrylic display screen, wipe it with a soft cloth (like the one supplied) onto which you have sprayed a window-type cleaner. Do not spray cleaners, spray/pour any liquid, nor wipe any abrasive cleaner on the screen nor any surface of the Tablet PC. Do not use tissues or paper towels to clean the screen. They contain wood fibers and may scratch the surface.

Will scratches affect the performance of the display or digitizer?

- Our testing has not found appreciable loss of performance on a scratched display.

How sensitive is the screen to various elements?

- As with any computer or electronic device, you should protect the Tablet PC from liquids, dirt and sand, other contaminants, and extreme heat.

Will any monitor, USB device, keyboard, or mouse work with the Tablet PC?

- If the device has a driver for Windows, it will work with the Tablet PC. For a list of products that have been tested for Windows, go to the Windows Marketplace Tested Products page at www.microsoft.com/whdc/hcl.

Why is the Tablet PC lacking parallel, serial, and PS2 (mouse) ports?

- Microsoft Tablet PC certification requires the system to be completely Grab-and-Go—that is, to be able to dock with and undock from all accessories without putting the system into suspend or shutting it down. Connecting through legacy ports such as serial, parallel, and PS2 often requires suspending or restarting the system, which prevents you from moving between desktop mode and mobile mode seamlessly in one docking/undocking step.

How do I adjust the Tablet PC for left-handed use?

- Open the Tablet and Pen Settings window (page 22). You can select left- or right-handed and change the location of the menus. You should calibrate the pen if you change any pen options (page 6).
Specifications
You can use System Information to find out more about your hardware and software environment. From the Start menu, choose All Programs > Accessories > System Tools > System Information.

You can find the specifications for other Motion Computing products at www.motioncomputing.com/products.

Warranty and Insurance Programs
Motion Computing currently provides limited warranties on Motion products and accessories. See the Warranty packaged with your Motion product or accessory or visit our Web site at www.motioncomputing.com.

In addition, Motion Computing offers extended warranties along with various screen and configuration insurance programs. Go to the Motion Computing Support and Services page at www.motioncomputing.com/support.

Service and Support
If you need help with your Motion Computing LE1700 Tablet PC, go to the Motion Computing Support and Services page at www.motioncomputing.com/support.

This page will provide you links to all the information you need about Motion products, technical support, customer services and professional services.
Index

Numerics
10/100/1000 Base-T Ethernet
   about 14
   using 24
802.11a/b/g
   about 16
   enabling 46
   setting up 46
   switch 2
   using 46

A
AC adapter
   about 17
   using 5
accessory port 4
adjusting display brightness 24
alarms 30
ALS See ambient light sensor
Alt + Tab 9
amber lights 10
ambient light sensor 3, 12
angle of acceptance
   about 27
   using 27
audio in port 2
audio out port 2
Automatic Updates 43

B
backup procedure 59
battery
   about 3, 18
   checking status 32
   gauge 32
   notification area status 32
   status light 10
   swapping 34
   tips 33
   using 32
BIOS
   setting a password 44
   blinking lights 10
   blue lights 10

Bluetooth
   about 16
   discovery 49
   enabling 48
   setting up 48
   tips 50
   using 48
bookmarks, using 1
Broadband Wireless
   enabling 47
buttons
   about 9
   configuring 23
   functions 9

calibrating the digitizer 6
calibrating the pen 6
capturing a fingerprint 37
care and maintenance
display 54
fingerprint reader 56
general care 53
pen 57
replacement pens 57
replacing pen tips 57
screen 54
tablet pen 57
View Anywhere display 54
character pad 22
charging the battery 32
checking battery gauge 32
checking battery status 32
configuring
   front panel buttons 23
   pen options 22
   rotation sequence 25
connecting
   external speakers 28
   headphones 28
   microphone 28
cord 17
Ctrl+Alt+Del 3, 11
customizing buttons 23
D
Dashboard
  starting 20
  using 20
Dashboard button
  about 3, 9
  configuring 23
dictation mode 28
digital monitor port 14
digitizer pen
  about 21
  calibrating 6
directional pad 3, 9
disabling
  the eraser 22
  the pen button 22
display
  about 11
  brightness 24
dynamic brightness 24
  extended 26
  features 11
  fixed brightness 24
  mirrored 26
  rotating 25
  rotation sequence 25
  using 24
disposing of used batteries 35
docking port 4, 14
document, about 1
DVI port 2, 14
dynamic brightness 24

E
enabling
  802.11a/b/g 46
  Bluetooth 48
  Broadband Wireless 47
  eraser 22
  Hibernate 31
  pen button 22
  Wi-Fi 46
eraser
  about 21
  enabling 22
Esc button
  about 3, 9
  configuring 23
Ethernet
  connections 5
  port 2, 14
  using 24
  extended display 26
  external display 14
  connecting 14
  using 26

F
FAA wireless air travel requirement 59
features overview 7
finding additional tablet PC software 51
fingerprint reader
  about 3, 11
  setting up 37
  tips 39
five-way directional controller 3, 9
fixed brightness 24
flashing lights 10
frequently asked questions 67
front panel buttons
  about 9
  configuring 23
front panel lights 10
Function button
  about 3, 9
  configuring 23

G
getting started 5
Gigabit Ethernet 14

H
handwriting recognition
  about 21
  using 22
hardware overview 2, 7
HDD password, setting up 45
headphones port 2, 13
headphones, connecting 28
Hibernate
  about 30, 31
  enabling 31
  using 31

I
indicator lights 10
Infineon Security Platform Tools 10
infrared
  about 4, 13
  using 51
infrared data association 13
Input Panel
  starting 9
  using 22
insurance 69
integrated microphones 12, 27
integrated speakers 12
Internet Options 43
IrDA
  about 4, 13
  using 51
K
key button 11
keyboard 22
L
landscape mode 25
LCD
  about 11
  care and cleaning 54
  View Anywhere 12
Li-ion battery 18
liquid crystal display See LCD
Lithium-ion battery See Li-ion battery
logging on to a remembered site 40
M
maintenance
  backup 59
  recovery 59
maintenance procedures 53
medium angle setting 27
memory card slot 15
microphone port 2, 13
microphones
  about 12
  built-in 3
  external 28
  using 27
mini-plug 17
mirror display 26
monitor only display 26
monitor port 14
Motion Dashboard
  using 20
  Motion Dashboard button 9
N
narrow angle setting 27
network connections 5
network port 14
networking
  Bluetooth 16
  wireless 16
O
OmniPass
  about 11, 37
  starting 37
on-screen keyboard 22
ordering replacement pens 57
overview
  hardware 7
  ports and connectors 2
P
Page Down 9
Page Up 9
password replacement
  about 39
  using 40
PC card
  about 4, 15
  using 15
PC card slot 4, 15
PCMCIA See PC card
pen
  about 21
  actions 21
  bay 4
  calibrating 6
  care and maintenance 57
  configuring options 22
  storing 21
  tether 4, 21
plug 17
plugging in 5
portrait mode 25
power adapter
  about 17
  port 4
  using 5
power cord
  about 17
  using 5
power light 10
power meter 30
power schemes 29
power switch 2

R
recovery procedure 59
removing the battery 33
replacing pen tips 57
replacing the battery 33
right-clicking 21
RJ-45 jack 14
Rotate button
about 3, 9
configuring 23
rotate sequence 25
rotating the display 25

S
SD card slot
about 4, 15
using 15
Secure Digital See SD card slot
security
features 10
using 10
security slot 2, 14
service 69
setting up
802.11a/b/g 46
a BIOS password 44
an HDD password 45
Bluetooth 48
strong logon security 42
the fingerprint reader 37
the tablet PC 5
users and passwords 44
Wi-Fi 46
Windows user accounts 44
Shift +Tab 9
skew angle 28
Speak Anywhere 27
speakers 3, 12
speakers, external 28
specifications 69
speech recognition
about 28
setting up 29
Standby
about 31
using 31
starting a Wireless Link 51
status lights 3, 10
strong logon security
about 42
enabling 42
support 69
swapping batteries 34

T
Tab key 9
Tablet and Pen Settings 22, 23
tablet only display 26
Tablet PC Input Panel
starting 9
using 22
tablet PC tutorials 5
TPM 10
traveling with your tablet PC 58
troubleshooting
audio 66
battery 64
display 64
input 65
network 66
ports and connectors 66
power 63
system 67
Trusted Platform Module 10
turning on the tablet PC 5
tutorials, Windows XP Tablet PC Edition 5

U
universal serial bus See USB
USB
about 13
ports 2
using 24
<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>using</td>
<td>1</td>
</tr>
<tr>
<td>802.11a/b/g</td>
<td>16, 46</td>
</tr>
<tr>
<td>angle of acceptance</td>
<td>27</td>
</tr>
<tr>
<td>battery</td>
<td>32</td>
</tr>
<tr>
<td>Bluetooth</td>
<td>48</td>
</tr>
<tr>
<td>Ethernet</td>
<td>24</td>
</tr>
<tr>
<td>external display</td>
<td>26</td>
</tr>
<tr>
<td>handwriting recognition</td>
<td>22</td>
</tr>
<tr>
<td>Hibernate</td>
<td>31</td>
</tr>
<tr>
<td>infrared</td>
<td>51</td>
</tr>
<tr>
<td>Input Panel</td>
<td>22</td>
</tr>
<tr>
<td>microphones</td>
<td>27</td>
</tr>
<tr>
<td>OmniPass</td>
<td>37</td>
</tr>
<tr>
<td>PC cards</td>
<td>15</td>
</tr>
<tr>
<td>power management</td>
<td>29</td>
</tr>
<tr>
<td>SD cards</td>
<td>15</td>
</tr>
<tr>
<td>security</td>
<td>10</td>
</tr>
<tr>
<td>skew angle</td>
<td>28</td>
</tr>
<tr>
<td>speech recognition</td>
<td>28</td>
</tr>
<tr>
<td>Standby</td>
<td>31</td>
</tr>
<tr>
<td>this document</td>
<td>1</td>
</tr>
<tr>
<td>USB</td>
<td>24</td>
</tr>
<tr>
<td>Wi-Fi</td>
<td>46</td>
</tr>
</tbody>
</table>

| W | warranty | 69 |
|   | white lights | 10 |
|   | wide angle setting | 27 |
|   | Wi-Fi | |
|   | about | 16 |
|   | enabling | 46 |
|   | setting up | 46 |
|   | switch | 2 |
|   | using | 46 |
|   | Windows Firewall | 43 |
|   | Windows Journal | 9 |
|   | Windows Security button | 3, 11 |
|   | Windows Security Center | |
|   | about | 43 |
|   | using | 43 |
|   | Windows XP Tablet PC Edition | |
|   | about | 5 |
|   | tutorials | 6 |
|   | wireless | |
|   | 802.11a/b/g | 16 |
|   | Bluetooth | 16 |
|   | infrared | 13 |
|   | Wireless Link | |
|   | using | 51 |
|   | wireless networking | 16 |
|   | writing pad | 22 |

| Y | yellow lights | 10 |